
Presto 1.4
New Features Overview 

 
 
Enterprise Mashups are a revolution and they are bringing user-centric features like 
interactivity, data mashups, and collaboration to center stage.  Leveraging the 
technological innovations of this Web 2.0 paradigm shift, forward-thinking 
enterprises are finding ways for their knowledge workers to quickly leverage 
internal and public data and share insights to achieve competitive advantage.    
 
The complexity of ad-hoc data integration inherent in large organizations is 
compounded by the quantity of disparate applications and business processes 
needed to complete a task.  Important data can be spread across CRM, billing, 
operations, ERP, ECM, and other repositories. Knowledge workers need a solution 
that streamlines long-winded, manual data mashup activities by utilizing the 
collaborative nature of Web 2.0 solutions.  They need an approach that makes 
them the center of the solution. 
 
JackBe has met these needs with Presto, an Enterprise Mashup Platform that allows 
enterprises to enable user-focused business-unit mashup solutions via the Five C’s 
of enterprise mashups: Consume, Create, Customize, Collaborate, and Confidence.   
 
 CONSUME: Secure, on-

demand access to data services 
from enterprise SOAs, partner, 
and public data services.  

 CREATE: Powerful, flexible, 
and intuitive driven data 
integration capabilities meeting 
the needs of advanced 
developers and power users. 

 CUSTOMIZE: Rapid customization of mashups via user-specified business 
rules and formatting preferences for perfecting mashup data results. 

 COLLABORATE: Easy tagging, classification, and sharing of data mashups 
across relevant users, teams, departments, or communities. 

 CONFIDENCE: Compliance with enterprise security & governance policies for 
data access and collaboration. 

 
Presto is composed of three primary components: the Presto Edge enterprise 
mashup server, Presto Studio for mashup RIA development, Presto Dash; a user-
driven Web 2.0 mashup portal.  More information about Presto can be found online 
at http://www.jackbe.com/products/index.php.  
 
 
What’s New in Presto 1.4 
 
Presto 1.4 debuts APIs and supporting documentation and code samples that are 
designed to open up new and powerful data integration possibilities through 
existing enterprise portal infrastructures and Rich Internet Application (RIA) 
toolsets.  The Presto Connect API allows you to quickly incorporate mashups into 

http://www.jackbe.com/products/index.php


your enterprise RIAs while the Presto Portal Integration Guide allows you to 
incorporate mashups into corporate portals to better serve your users.  Presto 1.4 
also includes significant enhancements to the Presto Edge enterprise mashup 
markup language (EMML) for implementing dynamic expression templates and data 
selection clauses within your mashup scripts.  Finally, improvement has been made 
to improve usability and efficiency in building Mashup RIAs using Presto Studio.   
 
The remainder of this document summarizes the new capabilities of Presto 1.4: 
 

Easy Enterprise Mashup Integration 
 Presto Connect Mashup API 
 Presto Portal Integration Guide 
 Improved LDAP and SSO Support 
 Expanded Operating System Support 

Mashups for Better Business Decisions 
 Easier EMML Readability and Scripting 
 Dynamic Filtering & Expressions 
 More Powerful JOIN’s 
 Basic Web-Clipping Support 

Rich Mashup Visualization 
 Flash Charts & Google Map Mashlets 
 Enhanced IDE Navigation & WYSIWYG 
 Improved Data Binding 
 Rules Validation for Mashup RIA’s 

 
 
Easy Enterprise Mashup Integration 
 
 

  Presto Connect Mashup API 
 
Presto Connect is a JavaScript library that allows any 3rd-party RIA web application 
toolset to integrate Presto Mashups.  Presto Connect provides APIs to connect to 
the Presto Server and invoke mashups and other data resources.  Our JSON-based 
‘JUMP’ protocol is used to access Presto Mashups and other individual data services 
via the widely accepted SOAP and REST protocols.  
 

   Presto Portal Integration Guide 
 
The Presto Portal Integration Guide features suggested portal integration 
architectures and examples for consuming Presto mashups in a portal environment. 
The portal integration guide provides general design guidelines that can be 
referenced when planning Presto mashup integration with portals.  Approaches 
based on JSR-168 Portlet and Web Services for Remote Portlets (WSRP) are 
covered.   
 
Integrating Presto into a portal environment provides a simple but powerful way to 
consume mashups, integrating disparate data regardless of varying technologies 
(such as RSS, REST, SOAP, RDBMS, etc.) and subsequently delivering ad-hoc, user-



specific mashup applications into portal environments, while operating within a 
single security/governance environment. 
 

Increased LDAP and SSO Support  
As part of our integration with Oracle WebCenter and Oracle Portal, we have 
validated Presto’s ability to work with the Oracle LDAP and SSO components that 
power Oracle’s application infrastructure.   

 

 Expanded Operating System Support 
Presto 1.4 now runs on Windows Vista and Sun’s Solaris 5.10 operating systems.  
Support for these two platforms means that Presto is now even more ready for 
enterprise mashup deployment in your organization.   

 

 
Mashups for Better Business Decisions 
 

 Improved EMML Readability and Ease of Use  
The Presto Enterprise Mashup Markup Language (JMML) is a sophisticated method 
for developers to create powerful data mashups for use in business applications.  
With this release, we are increasing the EMML’s ease of use and power.  It is 
important to note that these JMML enhancements not only help technical 
developers code Presto data mashups, they also make it easier for JackBe and 
other software vendors, OEM’s, partners, etc to create different user-driven mashup 
interfaces that leverage Presto enterprise mashup server.  EMML 
readability/usability enhancements include: 
 

 Standard approach to namespaces  
 Easier declaration of output variables 
 Implicit creation of output variables  
 Eliminate need to delimit service invocation data with CDATA tagging 

 

 Improved Data Mashup Capabilities  
Presto 1.4 improves Presto’s ability to address two key enterprise mashup 
requirements: 
 

1. Ad-Hoc, Dynamic Mashups 

2. Inconsistencies in Source Services/Data  
 
Through the use of dynamic expressions for filtering, Presto now has a very flexible 
method for building mashups that are ready to receive input variables.  This means 
that a Presto mashup can be built to execute based on a variety of user-defined or 
situational events (e.g. changes in a stock value on a website or user input of a 
date range). 
   
Presto 1.4 includes a new capability for developers to leverage powerful Xpath 
functions and logical operators in JOIN statements.  By using functions in JMML 
commands such as JOIN,  Presto supports requirements such as renaming column 



fields (e.g. ADDR to Address) or  replacing records values (Walmart to Wal-Mart) 
thereby allow JOIN mashups to take place.  Other new MML enhancements include: 
 

 Dynamic Expression Templates for Filtering Mashups 
- Create dynamic parameters or strings on the fly to filter data 
- Integration of filtering commands within the Invoke Statement 

 Select Statement for faster vertical refinement of data 
 More Powerful Join Mashups 

- Xpath functions are supported within the JOIN statement 
- Conditional Joins using logical operators 

 
These features will become a framework for more powerful data normalization 
capabilities in future Presto releases. 

 

 Web-Clipping Support  
Presto’s basic web-clipping feature allows Presto to consume data from web pages 
to be included in mashups.  The feature is attained through the use of JMML.  
 
 
Richer Mashup Visualization 
 

 Flash Charts & Google Map Mashlets  
 Charting: Adobe Flash-based charts now available for richer, more 

compelling visualization of Presto data within Dash.  Presto supports any 
type of UI, including Ajax and Flash. Users can select between the existing 
simple graphics (bar, line and pie charts) or the new Flash-based charts. 
You can also choose Flash or Basic charting use for individual mashlets.  

 Google Map Mashlet: Google Maps are now supported, in addition to OGC's 
Web Mapping Service for more flexibility when creating map-based 
Mashlets. 

 Colored Toolbar Tabs support further personalization by allowing users 
change the color of the tabs on their Web 2.0 desktop. 

 

 Enhanced IDE Navigation & WYSIWYG  

• The Preview tab in the JBML Model Editor can now be used as a visual 
design canvas. You can drag and drop widgets and their properties 
automatically update. If you change view and layout properties, this also 
updates the Preview. 

• Drag & drop nodes in the JBML Model Editor to reorganize widgets.  

• Expand All, Collapse All and Clear All buttons have been added to the 
Service Inspector view.  

• A <jbform> node automatically added when starting a new JBForm.  

• Drag and Drop widgets from the Gallery to the design area 

 



 Easier IDE-Based Data Binding  

• Bind operations or datasets automatically to the onClick property for 
Buttons. Simply drag either to the Button node.  

• You can automatically add an operation to a JBForm by binding an output 
node in the Service view to a widget. This will add binding information as 
well as adding the operation. 

• Drag operations anywhere in the Design tab canvas to add it to a JBForm. 
You no longer have to drop it on the JBForm node.  

• Many new features have been added for Mashup Scripts. 

 

 Pre-Population and Configuration Information Display  

 Pre-population of server-alias information for operations added to a JBForm 
pointing to the local host.  

 Binding information is now shown in the Design tab for operation input 
parameters and JBTable columns. 

 The Design tab has improved its display of widget nodes as you add them. 
It now automatically expands to show children widgets. In addition, the 
Property tab automatically loads the properties for the current widget.  

 The Presto License Manager now displays license expiration information 
when you open this with an existing license. You can choose to update the 
existing license with a new license.  

 You can see Presto and Studio version information in the About Presto 
Studio window available from the Help menu. 

 

 Binding Framework Enhancements  

 Binding always creates asynchronous connections.  

 Use of relative binding expressions in widgets by defining the beginning 
portion of the expression in parent or ancestor container widgets.  

 The dataPath property for JBTable columns has moved into cell editor 
elements to better support the variety of binding requirements based on 
the column type.  

 The JBML Migrator will properly relocate binding expressions for JBTables in 
existing projects. 

 A new syntax is available for binding one input parameter to an entire 
dataset (for complex object parameters).  

 PrestoOperation, DwrPrestoOperation and HttpOperation APIs 
available through JKB.delegate.JBFormDelegate.  

 The addition of Presto Connect APIs including: 
o JKB.connect.Connection 
o JKB.connect.HttpConnection 

 



 Rules Validation & Other EAF Changes  

 The Business Rule Engine has been added to EAF. Business rules are used 
to perform validations across a set of forms or objects.  For example, a 
business rule can perform calculations or change the enabled or editable 
state of widgets. They are applied only when all required widgets for the 
rule have a value. 

 Widget Groups, <widget-groups>, can now be used with JBForms. Widget 
groups allow you to define sets of widgets to which business rules should 
be applied. Widgets do not have to be contiguous.  

 
Please refer to the Presto 1.4 Release Notes for additional detail on enhancements, 
exceptions, and information related to resolved issues and known issues in Presto 
1.4.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
About JackBe  
 
JackBe provides a new user-driven tier of integration technology to power 
enterprise mashups. The resulting value is increased business unit freedom to 
access and integrate data & collaborate in a new style featuring rich Web 
interaction. JackBe’s standards-based Presto mashup platform unites the strengths 
of Ajax, SOA, & existing IT investments to help enterprise users be the killer app.   
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